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Abstract— Rat is one of the most common rodent species around 
the world . Even-though it is small in size it causes several damages 
. Many people have problem with rats in agricultural fields , storage 
areas , households ,offices , home appliances and even in 
automobiles . They eat the crop, contaminate the stored food and 
spread dangerous diseases to people and livestock . They cause 
damages to wires and other parts in automobile and household 
appliances . Even it causes damages to paper works in offices , cloth 
materials in textile industries etc ,. This project aims to create an 
ultrasonic repelling device using Arduino and IR sensor , and also 
buzzer is added to warn the user about the intruding of rats . The 
Prototype detect the rat using IR sensor and scare the rats away by 
emitting a high frequency ultrasonic wave and also an intrusion is 
notified to the user mobile through WIFI module .The whole 
prototype is enabled through the mobile application only whenever 

we required . 
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I. INTRODUCTION 
 

         Rats are the most destructive pest all over the world in various 
fields . Increasing rat population is one of the major reasons for 
reduced crop yields and causes farmers to suffer heavy losses 
because they started to invade the field even from the initial stage 
and it continues to destruct it till the end . Farmers mostly uses a 
trapping technique which involve manual labor and it is very 
expensive [1]. Rat not only destroy the agricultural field , it also 
invade the storage areas once the yields of the agriculture are 
harvested and stored .This is the main issues in most of the 
government food storage warehouses because they store vast 
amount of food items for public distribution system (PDS) and also 
to help people during natural calamities . Rats can consume the 
stored food items and also contaminate the goods with their urine 
and feces [2]. The damages caused by rats not only limited to 
agriculture , it can also affect the Human health in various ways . 
Rat bite or scratches even their uring and dropping can cause 
several bacterial and some viral infection to Humans . They are 
known to spread over 35 diseases and the most common and 
dangerous diseases include salmonella, 

hantavirus,tularemia,choriomeningitis(LCMV) , leptospirosis and 
lymphocytic [3] . Another major problem caused by rats are in the 
automobiles and household appliances . Rats mostly during their 
breeding and reproduction season choose automobile engines and 
home appliances as their nest because of their internal compact 
structures .Generally the teeth of the rats are constantly growing 
which they get rid of them by grinding their teeth by chewing 
anything on regular basis .So when they are inside the engines or 
appliances , it starts to chew on the wires in order to get rid of the 
pain because of the growth in teeth and also to keep their teeth in 
great shape [4]. The damages caused by rat on agricultural field 
area easily found because of the open field area . But the damages 
caused in automobile parts and appliances are bit hard to notify 
because of their moulded designs . They can only be found when 
there is any technical issues appear when they are powered up . 
Sometimes those little damages they done in electrical wires can led 
to malfunctioning or even complete damage to the appliances and 
also it even led to the electrical sparking which in turn cause fire .In 
whatever causes , the damages they create can bring greater suffer 
to the Human beings .This project aimed to design a low cost IOT 
based repelling device which scares the rat away by generating a 
high frequency ultrasonic wave and also a notification is send to the 
user mobile about the intrusion of rat . This prototype is mostly 
used during night time because the rodent activity are high during 
that time . The device generates the high frequency wave only after 
a motion is detected and the whole set up is enabled and disabled 
through the mobile app whenever it required which reduces power 
consumption because it will not generate ultrasonic sound 
continuously . 

. 

II. LITERATURE SURVEY 
 

Budi A et al., [3] ,proposes a system that pulls bells producing 
sound to repel birds and controls the buzzer to repel rice field pests , 
birds and mouse using the Arduino ATmega 2560 which will 
regulate the performance of sensors and servo motors as a 
mechanical system 
      Ross et al., [9] , proposes a system called , RatSpy, a visual, 
low-power bait station monitoring system which wirelessly reports 
both on bait station levels and intruders entering the bait station to a 
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custom designed cloud platform which reducing manual labour, 
improving scalability and data about the pest in field . 
      M. A. M. Fisol and W. M. Jubadi , [4] , proposes an ultrasonic 
repelling device has been developed to solve the problem in 
controlling the population of rats and scared them away from 
entering paddy field by using Passive Infrared Sensor (PIR) to 
detect the motion of rat and then emits high frequency ultrasonic 
wave to expel intruding rats away. 
       
 
C. Cambra et al., [2] , proposes the design of a smart IoT 
communication system for detecting rodents . The movements of 
rodents and the trapping estimation for periodical dates on each 
company or selected area can be remotely monitored by accessing to 
the multimedia platform through mobile phone or via computer 
Matikainen-Ankney et al., [6] , present a simple PIR-based activity 
logger, the rodent activity detector (RAD) which is a low cost and 
simple design , ideal for activity monitoring in high-throughput 
experiments and multi-site studies 

 

 

III. PROPOSED WORK 
 

The proposed project senses the motion of rodents using a 
PIR sensor , and once the motion is detected it starts generating 
high frequency ultrasonic wave of about 65 KHZ which disturbs 
and scares the rat away and also a notification is send to the 
mobile once the motion is detected . In addition to the ultrasonic 
frequency generator , an active buzzer is also used to produces a 
warning sound to alert the user about the intrusion of rodents .The 
prototype uses NodeMCU WIFI module which sends notification 
to the user mobile once motion is detected . In this project , even 
though the supply is given to the whole hardware setup initially , it 
is in idle state until it was enabled through the mobile app which 
reduces both the power consumption and an unwanted motion 
detection of humans in that area . once the humans are settled for 
night time sleep , the prototype is enabled , it started to sense the 
area for any motion detection. 

 

  A. Overall system setup 
 

The overall system setup is shown in Figure 1. 

                                     
                            Fig (1).Overall system setup 

 
B. Block diagram 
     

Figure 2 shows the block diagram of IOT based repelling device 
which consists of NodeMCU , Arduino Nano , PIR sensor and 
Buzzer modules .  

 

 
Fig (2) . Overall Block Diagram 

 

C. Block Diagram Description 

NodeMCU is an open-source IoT platform , which is a 
Microcontroller unit with WIFI capability . Here PIR 
sensor,LED , active buzzer all are connected to the 
NodeMCU . And another microcontroller unit Arduino Nano 
is also used which is attached to PIR sensor . Passive buzzer 
module is attached to the Arduino Nano . In this setup even 
though a power supply is given , sensor does not start sensing 
until it will be enabled through the mobile app which reduces 
the power consumption . Once the setup is enabled , PIR 
starts to sense the surrounding area for any motion of rodents 
. when rodent comes into the FoV of the sensor , passive 
buzzer attached to the Arduino Nano started to generate high 
frequency ultrasonic frequency which disturb the rodent and 
scare away it . And also once the motion is detected , 
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NodeMCU send a notification to the mobile app and an 
active buzzer produce beep sound to alert the user .  
      This project uses passive buzzer module to generate High 
frequency ultrasonic frequency . We can’t produce ultrasonic 
frequency using NodeMCU so Arduino Nano is used to 
generate the desired frequency using passive buzzer module . 
Once the motion is detected , NodeMCU sends a trigger 
signal to the Arduino Nano which in turn using passive 
buzzer module generate an high frequency ultrasonic 

frequency to scare the rat away from that surroundings .  

 

IV. HARDWARE AND SOFTWARE 

COMPONENTS 
 

The Hardware components used are : 

Generic ESP8266 NodeMCU  

Arduino Nano  

PIR sensor  

Passive buzzer module  

Active Buzzer Module  

LED  

 12V Power supply 

 

The software tools used are : 

Arduino IDE  

Blynk 

 

VI. NodeMCU 

 NodeMCU is an open source firmware and IoT platform which 
is built around a very inexpensive System-on-a-Chip (SoC) called 
the ESP8266 . It integrates 802.11b/g/n HT40 Wi-Fi transceiver so 
NodeMCU not only connect to the internet , it can also set up a 
network of its own which allows other devices to connect to 
directly.The NodeMCU ESP8266 development board comes with 
the ESP-12E module containing ESP8266 chip having Tensilica 
Xtensa 32-bit LX106 RISC microprocessor. This microprocessor 
supports RTOS and operates at 80MHz to 160 MHz adjustable 
clock frequency . NodeMCU does not have a DC power jack and it 
can be powered using Micro USB jack and Vin pin8 (External 
Supply Pin) .It is programmed using Arduino IDE which is an 
Integrated Development Environment that runs both offline and 
online .Table 1 shows the specifications of NodeMCU. 

 
Table 1. NodeMCU Specifications 

 
 
 

VII. Arduino Nano 

The Arduino Nano is a small , complete , and breadboard- 
friendly board based on the ATmega328 microcontroller . Arduino 
Nano is the smaller version of Arduino UNO hence both has the 
same functionalities . It is programmed using Arduino IDE which is 
an Integrated Development Environment that runs both offline and 
online. 

 
Table 2. Arduino Nano Specifications 

 
 

 
 

 

VIII. PIR Sensor 

Passive infrared sensor is an electronic sensor which detects the 
infrared radiation ( IR ) in its surrounding environment . It uses a 
pair of pyroelectric sensors which trigger the PIR when the signal 
difference between these two sensors changes . Most common PIR 
sensors are comes with fresnel lenses in front of pyroelectric sensors 
in order improve the field of view of PIR sensor . It has 3 pins : vcc 
, ground and high/low output . There is an adjustment setup for time 
delay and sensitivity . It can be powered by supplying an voltage of 
5-12 v . The effective range of PIR sensor is about 10 meters ( 30 
feet ) 

 
Table 3. Ranges of PIR Sensors 

 

Microcontroller 32-bit ESP-8266 

Clock frequency 80 MHz 

Internal RAM 128KB 

Flash 4MB 

Operating voltage 3V to 3.6V 

Digital IO Pins 11 

Analog in pins 1 

Microcontroller ATmega328 

Clock frequency 16 MHz 

SRAM 2KB 

Flash 32 KB ( 2KB for Bootloader ) 

EEPROM 1KB 

Operating voltage 7 V to 12 V 

Digital IO Pins 22 ( 6 PWM ) 

Analog in pins 8 

http://www.ijsrem.com/
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IX. Passive Buzzer Module 

      Passive buzzer is an electromagnetic speaker which generates a 
sound signal of different frequencies . Unlike active buzzer , passive 
buzzer need AC signal to produce sound . Arduino uses tone() 
function which act as a signal source to generate the sound signal of 
desired frequency . The sound of the passive buzzer is controlled by 
varying the input signal . It has 3 pins : Vcc , Ground and I/O . The 
operating voltage is ranges from 3.3 to 5 Volts . 
 

X. Active Buzzer Module 

Active buzzer module is an audio signalling device which 
consist of piezo-electric buzzer . It has an in-built oscillating source 
so when a DC voltage is supplied , it generates a single tone 
independently using an internal oscillator . when the signal is high it 
produces a sound of approximately 2.5khz . Active buzzer is 
different from passive buzzer by means of generating a single tone 
only . It has 3 pins : Vcc , Ground and I/O . The operating voltage of 
the active buzzer module is 3.3 to 5 volts . 

 

XI. 12 v Power Supply 

Arduino Nano is connected to the 12v power supply and through 
which all other components are powered up . PIR sensor , active 
buzzer module , passive buzzer module all works on above 5v and 
hence they can be powered using Arduino Nano 5v output pin . 
NodeMCU’s operating voltage is between 3 v to 3.6 v , since it has 
an in-built voltage-regulator NodeMCU is also given 5v supply 
from the Arduino Nano which in turn bring down to 3.3 v by the 
voltage regulator . 

 

XII. Arduino IDE 

To program both the NodeMCU and Arduino Nano , we use 
Arduino IDE software. The Arduino Integrated Development 
Environment - or Arduino Software (IDE) - contains a text editor 
for writing code, a message area, a text console, a toolbar with 
buttons for common functions and a series of menus. 
 
      Programs written using Arduino Software (IDE) are called 
sketches. These sketches are written in the text editor and are saved 
with the file extension “.ino”. The message area gives feedback 
while saving and exporting and also displays errors. The console 
displays text output by the Arduino Software (IDE), including 
complete error messages and other information. The bottom 
righthand corner of the window displays the configured board and 
serial port. The toolbar buttons allow you to verify and upload 
programs, create, open, and save sketches, and open the serial 
monitor. 
     Before uploading the sketch, the correct items are selected from 
the Tools > Board and Tools > Port menus. On Windows, it's 
probably COM1 or COM2 (for a serial board) or COM4, COM5, 
COM7, or higher (for a USB board). After the correct serial port 
and the board is selected, the upload button in the toolbar is pressed. 
The Arduino software will display a message when the upload is 
complete, or show an error.  
     Libraries provide extra functionality for use in sketches, e.g. 
working with hardware or manipulating data. To use a library in a 

sketch, the Sketch > Import Library menu is selected. This will 
insert one or more #include statements at the top of the sketch and 
compile the library with your sketch. Because libraries are uploaded 
to the board with your sketch, they increase the amount of space it 
takes up. If a sketch no longer needs a library, simply delete its 
#include statements from the top of your code. There is a list of 
libraries in the reference. Some libraries are included with the 
Arduino software. Others can be downloaded from a variety of 
sources or through the Library Manager..  
 

XIII. Blynk 

Blynk is a hardware-agnostic IoT platform with white-label 
mobile apps, private clouds, device management, data analytics, and 
machine learning.Blynk was designed for the Internet of Things. It 
can control hardware remotely, it can display sensor data, it can 
store data, visualize it and do many other cool things.Blynk easily 
connects 400+ hardware models like Arduino, ESP8266, ESP32, 
Raspberry Pi and similar MCUs and drag-n-drop IOT mobile apps 
for iOS and Android in 5 minutes . 

 
V.  RESULTS AND DISCUSSIONS 

 
 Until the whole setup is powered up , it is in offline mode. 

Figure 3 show the offline mode of blynk app 

 Once the setup is powered up , it comes to online mode and 
NodeMCU connects with the Blynk server . Figure 4 shows the 
online mode of the blynk app 

SENSOR MINIMUM RANGE MAXIMUM RANGE 

Indoor passive 

infrared 

25 cm 20 m 

Indoor curtain 

type 

25 cm 20 m 

Outdoor passive 

infrared 

10 m 150 m 

Outdoor passive 

infrared Curtain 

detector 

10 m 150 m 

 
Fig ( 3 ) . Offline mode  
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 Even though Setup is in online mode , it does not start sensing 

until it is enabled through blynk app 
 Once it is enabled , it started to sense the surrounding area for 

rodent activity and notify when the motion is detected . Figure 
5 shows the notification in blynk app when the motion is 
detected 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

VI. CONCLUSION 

This work presents the Design of IOT based rodent repelling 
device in which high frequency ultrasonic sound is produced to 
scare the rat away from the surrounding area . It reduces the power 
consumption by enabling the system only when it is required rather 
than continuous ultrasonic frequency generation like in existing 
system . And also it send a notification to the mobile about the 
intrusion of rat . The results are promising since it can be activated 

only when it is required and also it can generate ultrasonic 
frequency only when the motion is detected . 
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Fig ( 4 ) . Online mode 

 

 
Fig ( 5) . Motion Notification 
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